
Overview of the Venus 7000 Sequence Designer

The Sequence Designer is used to design and edit sequences (made up of animation and text, for example) which will be 

displayed on your Daktronics display.

You can use your mouse to click on the buttons and toolbars in the main dialog box, or you can use the keyboard or mouse to 

access pull-down menus, many of which duplicate the buttons and toolbars.

Sequences of many different sizes, color technologies and pixel technologies can be created. Sequences can include graphic, 

text and data frames. Graphic frames can be created and edited with many tools, including pencil, paintbrush and eraser tools. 

Text can be entered into a frame in a wide range of styles and sizes. Data frames can be designed to display different types of 

data, including current time, date and    temperature.
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File Menu Commands

The File menu offers the following commands:

New     Opens a new sequence.

Open     Opens an existing sequence.

Close     Closes the active sequence.

Save     Saves the active sequence to disk.

Save As     Saves the active sequences to disk under a new name.

Save All     Saves all active sequences to disk.

Preview     Displays the sequence on your monitor as it would appear on the display.

Stop Preview     Stops the sequence previewing.

Pause Preview     Pauses the sequence previewing.

Preview Range     Allows you to preview a specified range of frames.

Acquire

 Select Source     Lists Twain hardware sources available for bringing images into sequences.
 Twain The Windows image device standard for bringing images into sequences.
 Video Image Reader     An optional hardware device that allows for bringing in images from a video source, such as a video 

camera.

Import

 Image / AVI     Allows you to import images and AVIs into a sequence.
 Text     Allows you to import text files into a sequence.
 V6000 Sequence     Allows you to import a V6000 sequence into a V7000 sequence.

Export

 Export     Allows you to export the current sequence to a Venus 6000 sequence.
 Export AVI     Allows you to export the current sequence to an AVI file.

Print     Prints a paper copy of a sequence, either all frames or selected frames.

Print Preview     Shows you what the printout will look like.

Print Setup     Offers printing options such as printer and paper size before printing.

Properties  Allows you to specify settings, such as compression, for the active sequence only.

Preferences     Allows you to set individual options that control the way the Sequence Designer operates.

Exit     Leaves the Sequence Designer application.



Edit Menu Commands

The Edit menu offers the following commands:

Undo     Reverses the last drawing action. For example, if you draw a line and immediately decide you want to remove it, choose 

Undo.

Redo     Reverses the Undo function. For example, if you draw a line, and then delete it using Undo, you can make that line 

reappear by choosing Redo.

Cut     Removes the selected object or text and places it on the clipboard where it is available to be pasted into another location.

Copy     Copies the selected text or object and places it on the clipboard.

Paste     Pastes the contents of the clipboard at the current cursor position.

Duplicate     Performs a copy and paste of the selected area of the frame..

Quad Mode  Toggles between Quad and normal modes.



View Menu Commands

The View menu lets you decide which toolbars and dialog boxes you want to display in your window. 

 

Standard Toolbar     Contains buttons for the most common operations used for a sequence file, such as New and Save.

Frame Toolbar     Contains buttons for some common operations used on a sequence, such as Insert Graphic Frame and Copy 

Frame.

Select Frame Toolbar    Contains buttons that allow the user to move quickly to any frame in the sequence.

Frame Dialog Bar     Displays properties for the current frame, such as effect types and rates.

Frame Number Bar     Displays the current frame number and the total number of frames in the sequence, as well as the current 

frame type.

Color Dialog Bar     Contains the palette of custom colors and patterns for use in a sequence.

Palette Bar     Contains the standard colors for the type of the sequence that is currently active.

Color Info Bar     Contains color information for foreground color, background color, and current pixel location color.

Draw Toolbar     Contains buttons for the drawing tools, such as Pencil and Brush.

Font Dialog Bar     Allows you to select the font and font styles, such as Bold or Left Justified, for use of text in a frame.

Extended Font Info Bar     Allows you to modify other properties of the current text block, such as Line and Character spacing.

Status Bar     Displays information about the current frame, such as frame number and current cursor location.

Save Toolbar Positions     Allows you to save the current positions of all active toolbars.

Load Toolbar Positions     Allows you to reset the toolbars to their saved locations.

Snap to Image     Resizes the active sequence window to the size of the frame.

Grid  Shows or hides a grid on all open sequences so that it appears more like a matrix display.

Show Text Frame Text     Shows or hides any text in a text frame.

Zoom

 In  Magnifies your view of the frame.
 Out     Reduces your view of the frame.
 Area  Magnifies your view of the frame a the current cursor location.

Load Custom Palette  Allows you to load any custom color palettes for the current sequence type.



Frame Menu Commands

The Frame menu offers the following commands:

Delete    Deletes the current frame.

Add    Inserts a frame.

Copy    Copies a selection

Duplicate    Duplicates the frame.

Go To Frame     Allows you to move to a specific frame.

Find/Change Color Allows you to replace certain colors with different colors in a range of frames.

Auto Transitions    Allows the computer to automatically assign entry transitions to new frames.

Set Transitions as Default    Set current frame’s transitions so new frames have the same (default) transitions.

Fetch (For more information, see Fetch Control Dialog)

From Other Allows you to fetch frames from another sequence. 

From This Allows you to fetch frames from this sequence.

Combine (For more information, see Combine Control Dialog)

From Other Allows you to combine two frames from different sequences using operations such as Invert.

From This Allows you to combine two frames from the active sequence using operations such as Invert.

Insert

Graphic Frame Inserts a Graphic frame, the default frame type used to create graphics and animations.

Include... Inserts an Include frame, which allows you to gather a list of sequences to play.

Data Frame... Inserts a Data frame, which can display data from input devices, such as a temperature 

sensor.

Transmit Data... Inserts a Transmit Data frame, which can send data to an exterior source.

Command... Inserts a Command frame, which can be used to control a VLink controller.

Text Frame Inserts a Text frame, in which text can be used similar to a word processor.

Properties    Allows you to modify characteristics of a frame, such as effect modes.

Next Frame    Moves forward one frame in the sequence. 

Previous Frame    Moves back on frame in the sequence.



Text Menu Commands

The Text menu offers the following commands:

Font Select    Allows you to choose font styles and sizes.

Bold    Makes text more prominent.

Italic    Italicizes text.

Underline    Underlines text.

Strikeout    Places a horizontal line through text.

Left    Aligns text along the left margin.

Center    Centers text between margins.

Right    Aligns text along the right margin.



Options Menu Commands

The Options menu offers the following commands:

Shadow    Shadows the area.

Clear     Clears the area.

Clear Color     Clears a specified color in the area.

Fill     Fills the area with the foreground color.

Fill/Add Color     Adds the foreground color to the area.

Invert     Inverts all colors in the area.

Mirror     Flips the area horizontally.

Upside Down     Flips the area vertically.

Rotate

Rotate 180     Rotates the area 180 degrees.

CW 90     Rotates the area 90 degrees clockwise.

CCW 90     Rotates the area 90 degrees counterclockwise.

Arbitrary     Allows you to choose the degree of rotation.

Note: These commands affect the selected area, or the entire frame if no area is selected.



Tools Menu

The Tools menu offers the following drawing tools to use on a sequence:

Move     Moves the cursor in the frame.

Block     Used to select an area.

Text     Creates text in a graphic frame.

Pencil        Used to draw single pixels.

Erase        Erases information on the frame.

Brush     Draws with different brush shapes.

Bezier Curve Draws lines with smooth curves .

Line     Draws straight lines.

Ellipse     Draws circles and ellipses.

Rectangle     Draws squares and rectangles.

Get Color     Retrieves the color values from an area.

Fill     Fills an area with color.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of sequences in the 

application window:

New Window     Opens a new view of the current frame. This would be useful, for example, if you wanted to zoom in on the new 

window while editing in the original window.

Cascade     If you have several windows open, cascade arranges them in a series with the active window on top.

Tile     If you have several windows open, tile arranges them side by side and shows them in equal sizes.

Arrange Icons  If windows are minimized, Arrange Icons arranges them neatly at the bottom of the editing screen.



Help menu commands

The Help menu offers the following commands:

Help Topics     Allows you to access on-line help.

About Sequence Designer  Provides information about the software and about the Sequence Designer and Daktronics, Inc.



New command (File Menu)

Use this command to create a new Venus 7000 sequence. A dialog will appear allowing you to choose the sign type this 

sequence will be for, and specify the name of the sequence.

Shortcuts

Standard Toolbar:

Keys: Ctrl+N



Open command (File menu)

Use this command to open an existing sequence in a new window. You can open multiple sequences at once. Use the Window 

menu to switch among the multiple open documents. See Window 1, 2, ... command.

You can create new sequences with the New command.

Shortcuts

Standard Toolbar:

Keys: Ctrl+O



Close command (File menu)

Use this command to close all windows containing the active sequence. You should save changes to your sequence before you 

close it. If you close a sequence without saving, you lose all changes made since the last time you saved it

Shortcuts

Mouse: Click the Close icon on the sequence's window.

Keys: Ctrl+F4



Save command (File menu)

Use this command to save the active sequence to its current name and directory. If you want to change the name and directory 

of an existing sequence before you save it, choose the Save As command .

Shortcuts

Standard Toolbar:

Keys: Ctrl+S



Save As command (File menu)

Use this command to name and save the active sequence. The Sequence Designer displays the Save As dialog box so you can 

name your sequence and save it to a different directory if desired. 

To save a sequence with its existing name and directory, use the Save command.



Save All command (File menu)

Use this command to save all files that are currently open in the Sequence Designer. This will save you the time of having to 

save each file individually.

Shortcuts

Standard Toolbar:



1, 2, ..., 8 command    (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last eight sequences you closed. Choose the 

number that corresponds with the sequence you want to open.



Exit command (File menu)

Use this command to end your Venus 7000 Sequence Designer session. You can also use the Close command on the 

application Control menu or the application’s Close box. The Sequence Designer prompts you to save sequences with unsaved 

changes.

Shortcuts

Mouse: Double-click the application's Control menu button,or using the application’s Close box.

Keys: Alt+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, such as drawing or erasing. The Undo command cannot be used with some 

operations.

Shortcuts

Standard Toolbar:

Keys: Ctrl+Z or
Alt-Backspace



Redo command (Edit menu)

Use this command to redo the last editing action that was reversed with the Undo command. For example, if you drew a circle on 

a frame and select the Undo command, the circle will disappear. Selecting the Redo command will restore the circle.

Shortcuts

Standard Toolbar:

Keys: Ctrl+Shift+Z



Cut command (Edit menu)

Use this command to remove the currently selected data from the frame and put it on the clipboard. If no area has been selected 

with the Block tool, the contents of the entire frame are put on the clipboard.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Standard Toolbar:

Keys: Ctrl+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. If no area has been selected with the Block tool, the contents of the 

entire frame are put on the clipboard.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Standard Toolbar:

Keys: Ctrl+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the cursor position point. This command is unavailable if the 

clipboard is empty.

Shortcuts

Standard Toolbar:

Keys: Ctrl+V



Duplicate command (Edit menu)

Use this command to copy the selected area of the frame, then paste it at the current cursor location. The pasted area is 

selected and can be moved or modified as desired. If no area has been selected with the Block tool, the entire contents of the 

frame are duplicated. This can be used as a substitute for the Copy and Paste commands.



Quad Mode command (Edit menu)

Use this command to toggle the mode of the sequence between Quad and normal. A quad is a grouping of four pixels: red, blue, 

green and white. When in quad mode, the only pixels colored are those that are contained in the color being used. For example, 

if a green pencil is used in Quad Mode, only the green pixel of the quad will be colored. When not in Quad Mode, each pixel will 

be colored green.



Status Bar

Use this command to show or hide the Status Bar. The Status Bar shows the current frame number and cursor position, in terms 

of rows and columns. The Status Bar also shows a brief description of menu and toolbar options as you drag the mouse over 

them.



Save Toolbar Positions command (View menu)

Use this command to save the current positions of all toolbars. A dialog will appear allowing you to give a name to the saved 

positions. If you would like to reset the toolbar positions to a state that you saved, select the Load Toolbar Positions  command to 

choose a saved position.



Load Toolbar Positions command (View menu)

Use this command to load the saved positions of all toolbars. A dialog will appear allowing you load the default positions or a 

previously saved user-defined position. If you would like to save the current toolbar positions, select the Save Toolbar Positions .



Snap to Image command (View menu)

Use this command to force the window of the active sequence to resize itself to the size of the frame. This command may not be 

possible if the frame is zoomed to a large size.



Load Custom Palette Buttons command (View menu)

Use this command to load a saved set of custom colors into the Color Dialog Bar.



New Window command (Window menu)

Use this command to open a new window with the same contents as the active window. You can open multiple windows to 

display different parts or views of a sequence at the same time. If you change the contents in one window, all other windows 

containing the same sequence reflect those changes. When you open a new window, it becomes the active window and is 

displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Arrange Icons Command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an open sequence 

window at the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this 

document window.



Split Command (Window menu)

Use this command to split the active window into panes. You may then use the mouse or the keyboard arrows to move the 

splitter bars. When you are finished, press the mouse button or enter to leave the splitter bars in their new location. Pressing 

escape keeps the splitter bars in their original location. << In a single document interface application, this command will appear 

on the View menu. >>



1, 2, ... command (Window menu)

The Sequence Designer displays a list of currently open sequence windows at the bottom of the Window menu. A check mark 

appears in front of the sequence name of the active window. Choose a sequence from this list to make its window active. 



Index command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step instructions for 

using <<YourApp>> and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of the Venus 7000, as well as information 

about Daktronics, Inc.



Context Help

Use the Context Help command to obtain help on some portion of the Sequence Designer. When you choose the Standard 

Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark. Then click somewhere in the 

window, such as another Toolbar button. The Help topic will be shown for the item you clicked.

Shortcuts

Standard Toolbar:

Keys: Shift+F1



Title Bar

The title bar is located along the top of a window. It contains the name of the application and/or document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:

 Application Control-menu button
 Document Control-menu button

 Minimize button

 Maximize/Restore button

 Close button

 Name of the application

 Name of the document



Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars indicate your vertical 

and horizontal location in the frame. You can use the mouse to scroll to other parts of the frame.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note: This command is unavailable if you maximize the window.

Shortcuts

Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow keys.

Note: This command is unavailable if you maximize the window.

Shortcuts

Keys: Ctrl+F7



Minimize command (application Control menu)

Use this command to reduce the Sequence Designer window to an icon.

Shortcuts

Mouse: Click the minimize icon on the title bar as shown.

Keys: Alt+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcuts

Mouse: Click the maximize icon on the title bar as shown; or double-click the title bar.

Keys: Ctrl+F10



Next Window command (document Control menu)

Use this command to switch to the next open document window. The Sequence Designer determines which window is next 

according to the order in which you opened the windows.

Shortcuts

Keys: Ctrl+F6 or

Ctrl+Tab



Previous Window command (document Control menu)

Use this command to switch to the previous open document window. <<YourApp>> determines which window is previous 

according to the order in which you opened the windows.

Shortcuts

Keys: Shift+Ctrl+F6 or

Shift+Ctrl+Tab



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box or clicking the Close Box is the same as choosing the Close command.

Note: If you have multiple windows open for a single sequence, the Close command on the document Control menu closes only one 
window at a time. You can close all windows at once with the Close command on the File menu.

Shortcuts

Keys: Ctrl+F4 closes a document window

Alt+F4 closes the Sequence Designer window.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize command.

Shortcuts

Mouse: Click the restore icon on the title bar as shown, or double-click the title bar.



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a document using your 

application. 

If your application supports multiple document types and you want to have a distinct help topic for each, then use the help 

context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard. Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help context i.d. generated by 

MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first document type supported by 

your application. AppWizard produces an alias in the .HPJ file for your application, mapping HIDR_DOC1TYPE to the HIDR_ 

produced by MAKEHM for that document type. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx values from the [ALIAS] 

section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value. For example, AFX_HIDP_INVALID_FILENAME is the 

help topic for the Invalid Filename message box. >>



Acquire Select Source command (File menu)

Use this command to select a TWAIN compliant device for capturing images.



Acquire Twain command (File menu)

Use this command to acquire images from a TWAIN source.



Acquire Video Image Reader command (File menu)

Use this command to acquire images from a video camera.



Import Image/AVI command (File menu)

Use this command to import an image or a Windows Video file (AVI) into the active sequence. You can import images of many 

different types into your sequence. The image/AVI you choose can be manipulated in a number of ways before it is imported into 

the sequence. For more information, see Import Control Dialog

Shortcuts

Standard Toolbar:

Keys: Ctrl+Alt+F9



Import Text command (File menu)

Use this command to import a plain text file (.TXT) into the active sequence. The text can be formatted in a number of ways 

before it is imported into the sequence.

Shortcuts

Standard Toolbar:

Keys: Ctrl+Alt+F10



Import V6000 Sequence command (File menu)

Use this command to import a Venus 6000 sequence into the active sequence.



Export command (File menu)

Use this command to export the active sequence to a Venus 6000 sequence file. You will be prompted to enter a file name for 

the new sequence, then the Export Control dialog will appear and allow you to export frames.



Export AVI command (File menu)

Use this command to export the active sequence to a Windows Video (AVI) file. A dialog will appear allowing you to name and 

save the AVI file, and another will appear allowing you to change the frame rate and compressor for the AVI.

Shortcuts

Standard Toolbar:



File Properties

Use this command to view and change the settings for an individual sequence. The following settings can be changed: thumbnail 

frame, file compression, keywords, and notes.



Add command (Frame menu)

This topic is linked to the Insert Graphic Frame topic and will not be seen by the user.



Duplicate command (Frame menu)

Use this command to duplicate a range of frames and insert them in the active sequence. See also Duplicate Frame Dialog 



Find/Change Color command (Frame menu)

Use this command to replace a certain color with another color. You can replace colors in a certain frames or a range of frames.



Auto Transitions command (Frame menu)

When checked, this command randomly sets the transitions for every new frame. When a new frame is added, each frame will 

have a different transition mode.



Set Transitions as Default command (Frame menu)

Use this command to set the default transitions for every new frame. When a new frame is added, each frame will have the same 

transition modes as the frame that was set as the default. If the Auto Transitions  command is checked, the default transition will 

not be used.



Insert Include command (Frame menu)

Use this command to insert an Include (INC) frame into your sequence. The idea behind an Include frame is that if you want to 

display a number of sequences, all you need to do is create a list of sequences you would like to display. This way you will not 

have to fetch all of the frames of each sequence into one large sequence. The Include frame retrieves and displays each 

sequence in the list, one after another.



Insert Data Frame command (Frame menu)

Use this command to insert a Data frame (DAT) into your sequence. A Data frame is a frame that can receive data from a source 

outside the Venus 7000 software, such as a temperature sensor, and displays that data in a user-defined format. The following 

field types can be displayed in a Data frame: RTD (Real Time Data), Time, Date and Temperature.



Insert Transmit Data command (Frame menu)

Use this command to insert a Transmit Data (TXD) frame. A Transmit Data frame can be used to sends or transmits data from a 

sequence to an exterior source. For example, a Transmit Data frame could send a signal to the Soundburst digital audio system 

to start a sound.



Insert Command command (Frame menu)

Use this command to insert a Command (CMD) frame into your sequence. A Command frame is primarily used to send 

commands to a VLink controller. These commands include adjusting brightness and contrast levels and selecting a source. The 

Command frame can also be used to open a window on the display at a specified location.



Frame Properties

Use this command to change the properties for a frame. For more information, see properties: frames in the Venus 7000 Help 

Topics.



Clear command (Options menu)

Use this command to clear the contents of the frame or the selected area. This command is similar to the Cut command, except 

that it does not put a copy of the frame or area on the clipboard.



Clear Color command (Options menu)

Use this command to clear the current foreground color from the frame or selected area. For example, if the foreground color is 

red, and you select an area of the frame containing red, green and blue, choosing Clear Color will remove only the red pixels 

from the area.



Fill command (Options menu)

Use this command to fill the frame or selected area with the foreground color.



Fill/Add Color command (Options menu)

Use this command to add the foreground color to the frame or selected area. For example, if your foreground color is red, and 

you select an area of the frame containing blue, choosing Fill/Add Color will add red color to the blue, resulting in purple.



Invert command (Options menu)

Changes the colors in a frame to the direct opposite color. For example, black will be changed to white.



Mirror command (Options menu)

Reverses the object as it would appear in a mirror image.



Upside Down command (Options menu)

Turns the image upside down.



Rotate 180 command (Options menu)

Rotates the image 180 degrees.



Rotate CW 90 command (Options menu)

Rotates the image 90 degrees clockwise.



Rotate CCW 90 command (Options menu)

Rotates the image 90 degrees counterclockwise.



Rotate Arbitrary command (Options menu)

Allows you to select the exact number of degrees that the image will be rotated.



Move Tool

The Cursor Movement tool is used to change the cursor position within a frame. This can be done using either the mouse or the 

direction arrows on the keyboard.



Text Tool

The Text tool is used to place text on a frame.

To place text on a frame, click in the frame where you want the text to appear, then begin typing.

To change the paste style of the text, select the desired option from the tool options.



Pencil Tool

The Pencil tool is used to draw points or lines on a frame.

To draw points on a frame one at a time, click once in the frame. To draw lines in a frame, click in the frame and hold as you 

move the mouse, or use the direction arrows on the keyboard.



Erase Tool

The Erase tool is used to remove graphics from a frame.

To remove graphics from a frame, use the mouse or direction arrows on the keyboard to move the cursor over the areas you 

wish to remove.

To change the size of the Eraser, select the desired size from the tool options.



Line Tool

The Line tool is used to draw straight lines on a frame.

To draw a straight line, first select the desired line width. Next, click and hold where you would like the line to begin. Now, move 

the cursor to the point where you would like the line to end and release the mouse. The direction arrows on the keyboard can 

also be used to draw a line. To constrain the line to 45° angles, hold down the Shift key as you draw.

To change the width of the line, select a different line thickness from the tool options.



Ellipse Tool

The Ellipse tool is used to draw ellipses or circles on a frame.

To draw an ellipse, click and hold where you would like the ellipse to begin. Now, move the cursor to the point where you would 

like the ellipse to end and release the mouse. The direction arrows on the keyboard can also be used to draw an ellipse. To 

constrain the ellipse to a circle, hold down the Shift key as you draw.

To draw filled or unfilled ellipses, select the desired option from the tool options.

To resize a circle you just drew, click inside any of the handles (small squares) around the circle and drag the mouse. The 

handles will disappear when you click outside of them, and you will no longer be able to resize the circle.



Rectangle Tool

The Rectangle tool is used to draw ellipses or circles on a frame.

To draw a rectangle, click and hold where you would like the rectangle to begin. Now, move the cursor to the point where you 

would like the rectangle to end and release the mouse. The direction arrows on the keyboard can also be used to draw a 

rectangle. To constrain the rectangle to a square, hold down the Shift key as you draw.

To draw filled or unfilled rectangles, select the desired option from the tool options.

To resize a rectangle you just drew, click inside any of the handles (small squares) around the rectangle and drag the mouse. 

The handles will disappear when you click outside of them, and you will no longer be able to resize the rectangle.



Brush Tool

The Brush tool is used to draw on a frame.

The Brush tool works exactly like the Pencil tool, except that you can change the shape and size of the Brush tool.

To change the size or shape of the Brush tool, select the desired size from the tool options.



Fill Tool

The Fill tool is used to fill an area of a frame with a specified color.

To fill an area, select the desired color, then click in the frame inside the area you wish to fill.



Get Color Tool

The Get Color tool is used to retrieve color information from a frame.

To get color information from a frame,    click in the frame at the point you wish to get information color from.

To change the size of the Get Color tool, select a size from the tool options. The One Pixel size will pick up solid colors from a 

single pixel in the frame, the other sizes will pick up color patterns. 



Block Tool

The Block tool is used to select an area.

Once an area is selected, it can be cut, copied, moved (using the mouse or keyboard), or have a number of different operation 

performed on it, such as rotation. 

To select a block, simply click and drag in a frame to mark the area you wish to modify. To select a block with the keyboard, hold 

the CTRL key as you press the direction arrows.



Bezier Curve Tool

The Bezier tool is used to draw smooth curves on a frame using four control points.

To draw curves on a frame, click where you would like the curve to begin. Click again and hold, and move the cursor to the point 

where you would like the second control point to be, then release the mouse. Repeat for the third control point, and for the end 

point.

To change the width of the curve, select a different line thickness from the tool options.

To reshape a Bezier curve you just drew, click inside any of the handles (small squares) around the curve and drag the mouse. 

The handles will disappear when you click outside of them, and you will no longer be able to reshape the curve.



Tool Options

The Tools Options box contains options that apply to the current tool. 

The available options are: 

 Paste Styles, for use with the Move, Block and Text tools.
 Pixel Tool Styles, for use with the Erase, Get Color and Fill tools.
 Brush Styles, for use with the Brush tool.
 Line Thickness, for use with the Bezier and Line tools.
 Outline and Fill, for use with the Ellipse and Rectangle tools.



Bold Text

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Italic Text

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Underline Text

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Strikeout Text

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Justify Left

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Justify Center

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Justify Right

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Font Name

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.



Font Size

This topic is linked to the Font Dialog Bar topic and will not be seen by the user.





Print command (File menu)

Use this command to print a sequence. This command presents a Print dialog box, where you may specify the range of pages to 

be printed, the number of copies, the destination printer, and other printer setup options.

Shortcuts

Toolbar:

Keys: Ctrl+P



Print dialog box

The following options allow you to specify how the sequence should be printed:

Printer

This is the active printer and printer connection. Choose the Setup option to change the printer and printer connection.

Setup

Displays a Print Setup dialog box, so you can select a printer and printer connection.

Print Range

Specify the pages you want to print:

All Prints the entire sequence.

Frame # Prints the frame you specify.

Range Prints the range of pages you specify in the From and To boxes.

Copies

Specify the number of copies you want to print for the above page range.

Sequence Info

Specify the following information to print:

Transitions Prints the transitions for each frame.

Keywords Prints the keywords for the sequence.

Description Prints the description of the sequence.

Print Options

Specify the print options you want:

Invert Prints the sequence with colors inverted.

Grid Prints the sequence as a matrix of pixels.

Frames Per Page Allows you to specify how many frames are to be printed on each page.

Include Frame Text Prints the text contained in Include frames.

Data Frame Text Prints the text contained in Data frames.

Print Every X Frame Prints every Xth frame of the sequence. For example, if this is specified as 2, 

then every other frame will be printed.

Print Progress Dialog

The Printing dialog box is shown during the time that the Sequence Designer is sending output to the printer. The page number 

indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active sequence as it would appear when printed. When you choose this command, the main 

window will be replaced with a print preview window in which one or two pages will be displayed in their printed format. The print 

preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in 

and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print

Bring up the print dialog box, to start a print job.

Next Page

Preview the next printed page.

Prev Page

Preview the previous printed page.

One Page / Two Page

Preview one or two printed pages at a time.

Zoom In

Take a closer look at the printed page.

Zoom Out

Take a larger look at the printed page.

Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box, where you 

specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer

Select the printer you want to use. Choose the Default Printer; or choose the Specific Printer option and select one of the 

current installed printers shown in the box. You install printers and configure ports using the Windows Control Panel. 

Orientation

Choose Portrait or Landscape.

Paper Size

Select the size of paper that the document is to be printed on.

Paper Source

Some printers offer multiple trays for different paper sources. Specify the tray here.

Sequence Info

Specify the following information to print:

Transitions Prints the transitions for each frame.

Keywords Prints the keywords for the sequence.

Description Prints the description of the sequence.

Print Options

Specify the options you want:

Invert Prints the sequence with colors inverted.

Grid Prints the sequence as a matrix of pixels.

Frames Per Page Allows you to specify how many frames are to be printed on each page.

Include Frame Text Prints the text contained in Include frames.

Data Frame Text Prints the text contained in Data frames.

Print Every X Frame Prints every Xth frame of the sequence. For example, if this is specified as 2, then 

every other frame will be printed.



Font Dialog Bar Overview

This toolbar is used to select a font style and size for use with text in a sequence.

Choose the font face and size from these lists.

Makes the text more prominent.

Italicizes text.

Underlines text.

Places a horizontal line through text.

Aligns text along the left margin.

Centers text between margins.

Aligns text along the right margin.

Shows or hides any text in a text frame. See also Show Text Frame Text 



Frame Toolbar Overview

This toolbar is used for adding frames and changing the view of frames in a sequence.

Adds a new Graphic frame. For more information, see Insert Graphic Frame .

Adds a new Text frame. For more information, see Insert Text Frame .

Copies a frame. For more information, see Copy Frame .

Delete a frame or range of frames. For more information, see Delete Frame.

Zooms in on the current frame. For more information, see Zoom In .

Zooms out of the current frame. For more information, see Zoom Out .

Zooms in on an area around the cursor in the current frame.    For more information, see Zoom Area.

Displays a grid on the frame. For more information, see Show Grid .



Select Frame Toolbar Overview

This toolbar contains buttons for navigating the frames in a sequence.

Previews all frames. See also Preview command 

Stops previewing. See also Stop Preview command 

Pauses the preview. See also Pause Preview command 

Moves to the first frame. See also First Frame command 

Moves to the previous frame. See also Previous Frame command 

Moves to the next frame. See also Previous Frame command 

Moves to the last frame. See also Previous Frame command 

Previews a range of frames. See also Preview Range command 



Draw Toolbar Overview

This toolbar contains the following tools used for drawing and painting in a Venus 7000 sequence.

Moves the cursor in the frame. See also Move Tool 

Used to select an area. See also Block Tool 

 Creates text in a graphic frame. See also Text Tool 

 Used to draw single pixels. See also Pencil Tool 

 Erases information on the frame. See also Erase Tool 

 Draws with different brush shapes. See also Brush Tool 

 Draws lines with smooth curves. See also Bezier Tool 

 Draws straight lines. See also Line Tool 

 Draws circles and ellipses. See also Ellipse Tool 

 Draws squares and rectangles. See also Rectangle Tool 

 Retrieves the color values from an area. See also Get Color Tool 

 Fills an area with color. See also Fill Tool 

For information on the Tool Options, see Tool Options 



Standard Toolbar Overview

This toolbar contains buttons for the most commonly used operations on a sequence.

Creates a new sequence. See also New command 
Opens an existing sequence. See also Open command 
Saves the active sequence. See also Save command 
Saves all open sequences. See also Save All command 

Imports an image or AVI into the active sequence. See also Import command 
Imports a text file into the active sequence. See also Import Text command 
Exports the active sequence to a Venus 6000 file format. See also Export command 
Prints the active sequence. See also Print command 

Cuts the frame or selected area and places it on the clipboard. See also Cut command 
Copies the frame or selected area and places it on the clipboard. See also Copy command 
Pastes the contents of the clipboard into the frame. See also Paste command 

Undoes the last drawing action. See also Undo command 
Redoes the last action that was undone with the Undo command. See also Redo command 

Displays information about the Venus 7000 and Daktronics, Inc.
Displays context-sensitive help for items in the Sequence Designer.



Frame Dialog Bar Overview

This toolbar displays information about the current frame.

Properties

Brings up the Frame Properties dialog.

Entry / Hold / Exit

Shows the hold and transition effects for the current frame.



Frame Properties

This topic is linked to the Frame Dialog Bar Overview topic and will not be seen by the user.



Entry Mode

This topic is linked to the Frame Dialog Bar Overview topic and will not be seen by the user.



Hold Mode

This topic is linked to the Frame Dialog Bar Overview topic and will not be seen by the user.



Exit Mode

This topic is linked to the Frame Dialog Bar Overview topic and will not be seen by the user.



Frame Number Bar Overview

This toolbar displays the current frame number, number of frames in the sequence and frame type.

Frame … of …

Shows the current frame number and the total number of frames.

Type

Shows the type of the current frame, such as Graphic or Text.



Frame

This topic is linked to the Frame Number Bar Overview topic and will not be seen by the user.



Max Frame

This topic is linked to the Frame Number Bar Overview topic and will not be seen by the user.



Frame Type

This topic is linked to the Frame Number Bar Overview topic and will not be seen by the user.



Color Dialog Bar Overview

This toolbar displays the custom colors and patterns you can use on your sequence.

To edit a custom color, double click a color. A new window will appear allowing you to edit the color or pattern as you would edit a 

frame of a sequence.



Palette Bar Overview

This toolbar allows for the selection of the standard solid colors to use on your sequence.

Custom

Shows/hides the Color Dialog Bar.

Palette

Displays the standard Windows color dialog. Allows you to add colors to the Color Dialog Bar.

Swap

Swaps the foreground and background colors.

Quad

Enables/disables Quad Mode for this frame.



Color Info Bar Overview

This toolbar displays detailed color information about the foreground and background colors. Color information about the current 

cursor position is also displayed.



Extended Font Info Bar Overview

This toolbar displays additional information and characteristics about the text.

Char

Shows the current value for character spacing.

Word

Shows the current value for word spacing.

Line

Shows the current value for line spacing.

Mode

Shows the current insert mode. The modes are Insert and OverWrite.

Code

Shows the current formatting code, such as Font or Justification.



Insert Text Frame command (Frame menu)

Use this command to insert a Text (TXT) frame into your sequence. A Text frame is similar to a Text block in a Graphic frame, 
except that the text can be modified at anytime. Many styles can be applied to text in a Text frame, such as Bold or Left 
Justification. To speed up the process of inserting large amounts of text, the Import Text  command can be used to insert an 
portions of or an entire text file. 

Shortcuts

Frame Toolbar:



Copy command (Frame menu)

Use this command to duplicate the current frame and insert it at the current location in the sequence.

Shortcuts

Frame Toolbar:

Keys: Ctrl+Shift+D



Delete command (Frame menu)

Use this command to delete one or more frames in the active sequence. See also Delete Frame Dialog 

Shortcuts

Frame Toolbar:

Keys: Ctrl+Del



Zoom In command (View menu)

Use this command to magnify the window of the active sequence. The window can be zoomed in to a 16x magnification. This 
can be useful when modifying the contents of a frame on a pixel by pixel basis. To decrease the magnification of a window, use 
the Zoom Out  command.

Shortcuts

Frame Toolbar:

Keys: Ctrl +



Zoom Out command (View menu)

Use this command to decrease the magnification of the window of the active sequence. The window can be zoomed out so the 
entire frame can be seen at one time. To increase the magnification of a window, use the Zoom In  or Zoom Area  commands.

Shortcuts

Frame Toolbar:

Keys: Ctrl -



Zoom Area command (View menu)

Use this command to magnify the window of the active sequence. The window is zoomed to a high magnification, with the 
current cursor location being centered in the window. To further increase or decrease the magnification of the window, use the 
Zoom In  and Zoom Out  commands.

Shortcuts

Frame Toolbar:



Show Grid command (View menu)

Use this command to add a grid to all open sequences. The grid will appear as a matrix of black lines that will show a definite 
separation of pixels in the sequence. This is used to better show what the sequence will look like when shown on the display.

Shortcuts

Frame Toolbar:

Keys: Ctrl+Alt+O



Preview command (File menu)

This command is used to play the active sequence. The frames of the sequence will be displayed in order, using the hold times 
and transitions specified. The preview can be used to get an idea of what the sequence will look like when shown on the display.

Shortcuts

Select Frame Toolbar:

Keys: F5



Pause Preview command (File menu)

Use this command to pause the sequence being previewed. The sequence will stop at the current frame, and can previewing 
can be resumed at any time.

Shortcuts

Select Frame Toolbar:



Stop Preview command (File menu)

Use this command to stop the sequence being previewed. The sequence will return to the frame that was active before 
previewing began.

Shortcuts

Select Frame Toolbar:

Keys: Esc



Next Frame command (Frame menu)

Use this command to advance forward to the next frame in the active sequence.

Shortcuts

Select Frame Toolbar:

Keys: F12



Previous Frame command (Frame menu)

Moves back one frame in the sequence.

Shortcuts

Select Frame Toolbar:

Keys: F11



First Frame

Use this command to move to the first frame in the active sequence.

Shortcuts

Select Frame Toolbar:

Keys: Ctrl+Alt+Home



Last Frame

Use this command to move to the last frame in the active sequence.

Shortcuts

Select Frame Toolbar:

Keys: Ctrl+Alt+End



Preview Range command (File menu)

This command is used to preview a specified range of frames. A dialog will appear that will allow you to specify the first and last 
frames you wish to have previewed.

Shortcuts

Select Frame Toolbar:

Keys: Ctrl+Alt+R



Show Text Frame Text command (View menu)

Use this command to show or hide the text in a text frame. When the text frame is shown, the text can be modified, and any 
other graphic elements of the frame are hidden. When the text is hidden, the graphic elements are shown and can be modified.

Shortcuts

Font Dialog Bar:



Insert Graphic Frame command (Frame menu)

Use this command to insert a Graphic (GRP) frame into your sequence. The Graphic frame is the default frame type used in 
creating graphics and animations to show on the display. Standard drawing tools can be used to create graphics, and different 
graphic files, such as bitmaps and AVIs, can be imported and used in a graphic frame.

Shortcuts

Frame Toolbar:

Keys: Ctrl+A





Preferences Dialog Overview

This dialog is used to change default criteria for the Sequence Designer.

File Compression

Use this to set the level of compression for sequences. The three levels are None, Low and Medium.

Outline Width

This is the default outline width for the Outline paste style.

Marquee Box Width 

Specifies the line width of the marquee box when using the Block tool.

Skip Frames on Preview 

When checked, some frames will be skipped when previewing sequences to allow for faster playback.

Auto Save every … minutes

When checked, sequence will automatically be saved after a number of minutes you specify.

Monochrome ON Color 

Use this to specify the color of the pixels when editing a Monochrome sign. For example, if your sign is a red Monochrome 

sign, select your Monochrome ON Color as Red so you will have a better idea of how your sequences will look.



Frame Transitions

The following properties of a Graphic Frame can be changed:

Mode

These are the available effects for entering, holding and exiting frames when playing sequences..

Direction / Shape

These are the options available for the different modes. For example, if the mode is Roll, the possible directions are Left, 
Right, Up and Down.

Rate

These are the rates at which the effects are performed. Different modes can have different rates.

Hold Time

This is the amount of time, in seconds, that the frame holds. If a hold mode is specified, that effect will be performed for the 
duration of the hold time.

Range of Frames

When checked, you can specify a range of frames to apply selected modes and rates to.



Include Frame Params

The following parameters of an Include Frame can be changed:

Cut, Copy, Paste Icons

These icons allow you to quickly cut, copy or paste item(s) in the list.

Edit

Allows you to change the sequence to include for this item.

Add

Adds a new sequence to include at the end of the list.

Ins

Inserts a new sequence to include in the current position in the list.

Delete

Removes the selected item(s) from the list.

Enable/Disable

Enables or disables the selected item. If enabled, the sequence will be played. If disabled, the sequence will not be played.

Properties

Brings up the file properties for the selected item.



Data Field Parameters

The following parameters of a Data Field can be changed:

Field … of …

Specifies the current field number being modified.

Row/Col

The position, in terms of rows and columns, of the upper left corner of the field.

Font

The list of available fonts to use in a field.

Insert

Inserts a new field.

Delete

Deletes the active field.

Duplicate

Inserts a copy of the active field.

Text Color

Specifies the color of the text for the field.

Overlay Mode

Specifies the overlay mode for the field.

Field Adjustments

These buttons allow you to make accurate placements of the fields in the frame.

Align top edges of fields.

Align bottom edges of fields.

Align left edges of fields.

Align right edges of fields.

Make fields same length.

Center the fields horizontally in the frame.

Center the fields vertically in the frame.

Evenly space the fields horizontally.

Evenly space the fields horizontally.

Field Type

You can choose one of four field types: RTD, Time, Date and Temperature. Each field type 

has its own set of properties that can be modified.



Data Frame Parameters

The following parameters of a Data Frame can be changed:

Data Frame Fonts

Lists the fonts available for the data fields.

Select Brings up a font dialog that allows you to modify the style of the font.

Clear Removes the selected font from the list.

Input Template List

Lists the template files that were produced with the Venus 7000 Template Editor.

Select Allows you to choose a different template file.

Clear Removes the selected template from the list.

Update Item #’s Refreshs the list of files.



Transmit Data Frame Parameters

The following parameters of a Transmit Data Frame can be changed:

Description

Enter a description of the data here.

Output

Specifies which output is to be used for the data.

Hold Time

Specifies the time, in seconds, that the data should be shown.

Protocol

Specifies which protocol is to be used to send the data.

# Bytes

The size, in bytes, of the data.

Transmit Data

The data that is to be transmitted.

Hex View

Displays the hexadecimal representation of the data.



Command Frame Properties

The following properties of a Command Frame can be changed:

Edit

Allows you to edit the item in list.

Add

Takes you through a wizard-style dialog that allows you to add a specific command to perform.

Insert

Inserts a new command at the current position in the list.

Delete

Deletes the selected item.

Delete

All deletes all item from the list.



File Properties Dialog Overview

This dialog displays information about the active sequence.

General

File Name This is the complete path and sequence name.

Frame Size These are the dimensions in pixels.

Pixel Tech This is the pixel technology for this sign type. The three technologies are Incandescent, Reflective 

and LED.

Color Tech This is the color technology for this sign type. Quad64K is an example of a color technology.

Duration This is the duration, in seconds, of the sequence. This includes the duration of sequences listed in 

any Include frames that this sequence may have.

Frames The number of frames. This does not include the number of frames of sequences listed in any 

include frames that this sequence may have.

Thumbnail

Thumbnail Frame Enter the number of the frame you wish to use as a thumbnail.

Thumbnail This is what the selected thumbnail frame looks like.

Advanced

File Compression Use this to set the level of compression for this sequence. The levels are None, Low and 

Medium.

Keywords Enter any words here that you would use as criteria when searching for this sequence.

Notes Enter any notes you may have about this sequence, such as a brief description.



Import Control / Acquire Video Dialog

This Import Control dialog is used to import graphic and AVI files to a Venus 7000 sequence. The Acquire Video dialog is used to 

capture video into a Venus 7000 sequence.

Common Dialog Controls

These are the controls that are common to both the Import Control and the Acquire Video dialogs.

Browse

Brings up a standard Open dialog and allows you to select a different image or AVI to import.

Capture

Captures the image or the current frame of the AVI.

OK

Closes the Import Control or Acquire Video dialog and adds the captured frames to the sequence.

Close

Brings up a dialog that asks you if you wish to close the Import Control or Acquire Video dialog and save the results of 

the session, close the dialog and lose the results, or continue the session.

Frames Captured

Displays the number of frames you have captured during this session.

Zoom In/Out

Use these buttons to zoom the source and destination windows in and out.

Capture Rectangle

Height Specifies the height of the rectangle.

Weight Specifies the width of the rectangle.

X Pos Specifies the horizontal position of the upper left corner of the rectangle.

Y Pos Specifies the vertical position of the upper left corner of the rectangle.

Size Mode 

(Import Control

Use this list to specify whether to view the rectangle in terms of pixels or as percentage of 

the image. Changing this option will be reflected in the Height, Width, X Pos and Y Pos 

values.

Keep Aspect Check this to keep the aspect ration of the rectangle the same as that of the sequence.

Drop Image 

(Import Control)

Check this to drop the image captured by the rectangle.

Constrain Rect 

(Import Control)

Check this to constrain the capture rectangle.

Scale Video 

(Acquire Video)

Check this to scale the video.

Show Video 

(Acquire Video)

Check this to show the video.

Auto Center Check this to keep the capture rectangle centered at all times.

Image Levels

Use these slider bars to change the levels of the following characteristics: Brightness, Contrast, Hue, Saturation, Red, 

Green, Blue and White.



Common Dialog Menus

These are the menus that are common to both the Import Control and the Acquire Video dialogs.

Image Settings

Contains options that allows you to load, reset and save the current image settings (such as brightness and color levels.

Image

Contains options that allow you to flip, reverse or rotate the image.

Effects

Contains effects that you can apply to the image, such as Emboss and Mosaic.

Spatial Filters

Contains spatial filters that you can apply to the image, such as Gradient and Laplacian.

Color

Contains options that allow you to control the color of the image, such as converting it to grayscale or performing a 

gamma correction.

Import Control Dialog Controls

These are the controls that are present in only the Import Control dialog.

Multi-Frame Settings

Frame Use this to select the frame of an AVI you wish to view or capture.

Convert Frames Enter the range of frames you wish to capture.

Acquire Video Dialog Controls

These are the controls that are present in only the Acquire Video dialog.

Video Settings

Standard Choose either the NTSC or PAL video standard.

Signal Choose either a Composite or SVideo signal.

Frames/Sec Select on of the following frame rates for the captured video: 1, 2, 5, 10, 15 or 30 fps.

Record Starts capturing frames from the video signal.

Stop Stops capturing frames from the video signal.



Text Import Control Dialog Overview

The Text Import Control dialog is used to bring the contents of plain text (.TXT) files into your sequence. The text can be 
imported as Graphic or Text frames.

Output Text Font

Allows you to select the name and size of the output text, as well as set styles like Bold and Center Justification.

Output Text Color

Foreground The color of the text.

Background The color of the background.

Change... Allows you to change the foreground and background colors.

Swap Swaps the foreground and background colors.

Settings

Brings up the Import Text Settings dialog, where you can change settings that affect the way the text is imported.

Vertical Center

Centers the text vertically in the frame.

Text Frames … of …

Displays the current frame and total number of frames that can be imported.

Frames Captured

The number of frames that have been captured during this session.

Text Field

A field displaying the contents of the selected text file.

Clear Frames

Clears all frames. To create a new frame to capture, you must select some text in the Text Field and click Grab to Frame.

Grab to Frame

Grabs the selected text and puts it in a new frame or frames that can be captured.

Undo Grab

Removes the last frame or frames that were grabbed.

Source File

Displays the full path and file name of the text file being imported.

Browse…

Allows you to select a different text file to import.

OK

Captures all frames and adds them to the sequence.

Close

Brings up a dialog that asks you if you wish to quit the Text Import session and lose any frames you may have captured.

Refresh

Redisplays the contents of the frames to reflect any changes you may have made to the text.



Import Text Settings

This dialog contains additional settings you can use to modify the text being captured in the Text Import Control dialog

General

Apply to All Frames Applies the settings to all frames.

Word Wrap Wraps the words on a line similar to a word processor. When not checked, any lines that 
are too long will be clipped when captured.

Use BG Color As Fill When checked, the background color will be used to fill the area surrounding the text in a 
frame.

Clip Selected Text

To Fit Frame

When checked, any selected text that is grabbed to a frame will be grabbed to one frame 
only. When not checked, the selected text that is grabbed to frame will be grabbed to as 
many frames as necessary.

Outline Creates a black outline around the text using the specified width .

Lines Per Frame

Auto Automatically calculates the number of lines of text in a frame.

Manual Allows you to specify the number of lines of text you want in a frame.

Line Spacing Allows you to specify the amount of space between each line of text in a frame.

Output Frame Type

Specifies whether the captured text will be imported as a Graphic or Text frame.



Export Control Dialog Overview

This dialog lets you choose the range of frames of the current sequence that will be exported to a Venus 6000 sequence.

Use the arrows to view the frames in the sequence.

Enter the range of frames you wish to export in the boxes.

Click Convert to convert the specified frame(s), or click Cancel to dismiss the Export Control dialog.



Fetch Control Dialog Overview

This dialog is used to retrieve a specific frame, or a series of frames, from a sequence and bring the frame(s) into the current 

sequence

Frame Position

X Pos Specifies the horizontal position of the upper left corner of the frame being fetched.

Y Pos Specifies the vertical position of the upper left corner of the frame being fetched.

.

Stretch Mode

Checking this will enable you to resize the frame you are fetching.

Width Specifies the width of the frame being fetched.

Height Specifies the height of the frame being fetched.

Keep Aspect Keeps the dimensions of the frame being fetched the same as that of the sequence you are 

fetching into.

Fetched From

Frame … of … Use the spinner buttons or enter a number in the box to go to a specific frame to fetch.

Fetch Range Check this to fetch a range of frames. To specify the range, enter the first and last frame 

numbers in the boxes provided.

Frames Fetched

Displays the number of frames that have been fetched in the current session.

Convert Quad to Pixel

When fetching frames from a sign using Quad pixel technology, check this box to convert the quads to a single pixel.

Warn After Last Frame

When this box is checked, you will be alerted when you have reached the last frame in the sequence you are fetching from.

Fetch

Click this button to fetch the current frame, or a range of frames, into the sequence.

Reverse Fetch

When clicked, the current frame will be fetched, then the previous frame in the sequence will be displayed. If a range of 

frames is specified, the frames will be fetched into the sequence in the reverse order.

Browse...

Clicking this button brings up the Venus 7000 file dialog and allows you to select a different sequence to fetch frames from.

Close

Closes the Fetch Control dialog. If any frames have been fetched, you will be asked if you wish to save the results of the 

fetch session.



Combine Control Dialog Overview

This dialog is used to combine two frames together using different modes, such as Invert or Mask. The two frames being 

combined can come from the same sequence, or from two separate sequences. The resulting frames can be saved to the 

current sequence or to a new sequence.

Combine

Click this button to combine the current foreground and background frames using the current Combine Mode.

Close >

Save to Current Seq. Closes the Combine Control dialog and inserts the combined frames into the current 

sequence.

Save to New Seq. Closes the Combine Control dialog, creates a new sequence, and inserts the combined 

frames into the new sequence.

Cancel Session Closes the Combine Control dialog without saving any combined frames.

Frame(s)

Background Specifies the current frame of the background sequence.

Foreground Specifies the current frame of the foreground sequence.

Combine Mode

Specifies the effect used to combine the foreground and background frames.

Outline Size Allows you to change the width of the outline when using the Add/Outline Combine Mode.

Allow Repeat

When checked, the current frames will be combined, the frames will advance by one, then those frames will combined, and 

so on. The number of times that the frames are combined and advanced is specified in the Repeat Count box.

Warn After Last Frame

When checked, a dialog will appear informing you that the last frame of either the background or foreground sequence has 

been reached.

Zoom In/Out

Use these buttons to zoom the sequences in and out. The maximum zoom level is 16.

Background Sequence:

Clicking this button will allow you to specify a different sequence to use as the Background sequence.

Foreground Sequence:

Clicking this button will allow you to specify a different sequence to use as the Foreground sequence.

Background/Foreground Frame Movement

Choose whether you would like the frame to Advance, Stay or Reverse after combining.

Advanced Section

Background / Foreground Frame

X Pos Specifies the horizontal position of the upper left corner of the frame.

Y Pos Specifies the vertical position of the upper left corner of the frame.



X Inc Specifies the number of pixels to move horizontally after combining a frame. A positive value moves right, 

and a negative value moves left. 

Y Inc Specifies the number of pixels to move vertically after combining a frame. A positive value moves down, 

and a negative value moves up. 

Colors Specifies which color values are to be displayed in the current frame.

 



Duplicate Frame Dialog Overview

This dialog is used to duplicate a frame or a range of frames and place the frame(s) at a specified location in the sequence.

From … to …

Specify a range of frames to duplicate by entering the number of the first and last frames in the range in the From and To 
boxes.

Number of Times

Specifies the number of times to perform the duplication.

Insert at Frame

Specifies the frame number that will be the location of the first of the duplicated frames.

Duplicate Range 

Click to duplicate the specified range of frames.

Duplicate Current 

Click to duplicate the current frame.

Close 

Click to dismiss the Duplicate Frame dialog.



Delete Frame Dialog

This dialog allows you to delete a specific frame or a range of frames from a sequence.

From … to …

Specify the range of frames to delete by entering the number of the first and last frames in these boxes.

Delete Current

Deletes the current frame.

Delete Range

Deletes the range of frames specified. You will be asked to confirm the deletion of the frames.

Skip

Click Skip to advance to the next frame.

Close

Dismisses the Delete Frame dialog.



Go To Frame Dialog Overview

This dialog is used to go to a specified frame in the sequence.

To view a specific frame in a sequence, enter the number of the frame in the Go To Frame # box, then click OK.



Line Size Dialog Overview

This dialog box is used to edit the width of the line used with the Ellipse Draw, Rectangle Draw, Bezier Curve Draw and Line 

Draw tools.

To change the line width, enter a number between 1 and 255, or use the spinner button to select the desired width.



Shadow Dialog

This dialog is used to create a shadow effect for a frame or selected area. The color of the shadow is determined by the current 

foreground color in the Palette Bar. Note: when working with Quad color signs, an outline width of a least two must be used.

Direction

Press one of these buttons to create a shadow that direction.

Apply To

Current Frame Create a shadow only on the current frame.

Range of Frames Creates a shadow on the specified range of frames.

Outline Size

Specifies the length of the shadow.

Apply

Click this button to apply the shadow.

Close

Closes the Shadow Dialog.



Find / Change Color Dialog Overview

This dialog allows you to find and change color values in a frame or range of frames.

Color To Find / Color to Change To

Adjust Find Color Brings up the Edit Pattern Dialog to allow you to adjust the color values to find or change to.

Grab FG Gets the color values from the current foreground color.

Grab BG Gets the color values from the current background color.

Frames

From … to … Specify the range of frames you want to find and change colors for.

Find/Change Current Finds and changes color values for the current frame.

Find Change Range Finds and changes color values for the specified range of frames.

Advanced Options

Allows you to specify a range of color values to find and replace. For example, if your Red value to search for is 5 and your 
tolerance is 1, then all colors with a Red value between 4 and 6 will be changed.

Close

Dismisses the Find/Change Color dialog.



Edit Pattern Dialog Overview

Allows the user to customize the colors used in the design of sequences.

Color Sliders

Use the slide bars to change the intensity of the colors. This will affect either the entire pattern (if Solid Color is checked) or a 
pixel in the pattern.

Grab FG

Grabs the current foreground color for editing.

Grab BG

Grabs the current background color for editing.

Solid Color

Allows the user to edit as a solid color, rather than a pattern of colors.




